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iSYS-400x
GUI - description
The iSYS-GUI can be used to confi gure and display the measured signals of an iSYS-400x radar sensor.               
It displays the target list, FFT magnitude with threshold and the signal raw data.
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1. connecting the iSYS-400x to your PC
To connect the iSYS-400x with your PC use the following confi guration (complete cables can be purchased from InnoSenT).
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RS232-Connector
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Input Pin # Signal Pin # Output

Buchse M12x8 1 OUT1 1 Stecker M12x8

Buchse M12x8 2 OUT2 2 Stecker M12x8

Buchse M12x8 3 OUT3 3 Stecker M12x8

Buchse M12x8 5 VCC 5 Stecker M12x8

Buchse M12x8 6 GND 6 Stecker M12x8

Buchse M12x8 4 not connected 4 Buchse RS232

Buchse M12x8 6 GND 5 Buchse RS232

Buchse M12x8 7 RS232_Rx 2 Buchse RS232

Buchse M12x8 8 RS232_Tx 3 Buchse RS232
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2. installing iSYS-GUI
Software is available @ www.innosent.de
(Service -> Downloads ->Software)

• Download Software-Package for iSYS-4001
• Open folder iSYS-4001_iSYS-4002_iSYS-4003/GUI/...
• Double-click on „iSYS_GUI_vX.XXX.exe“ to start Setup-

Wizard.
• Follow instructions.

• Click „Finish“ to close setup and to launch GUI.

The sensor has a RS232 or RS485 interface (depending on sensor-type). An iSYS-4001 with RS232 interface can be 
connected directly to the COM port of the PC otherwise there can be a RS232 to USB adapter used. The Adapter installs 
a virtual COM port which can be selected in the GUI.

The sensor provides an M12x8 Conec type SAL - 12 - FSH8 - P5,5 - 9 (PN: 43-01071) with SAL - 12 - FKH8 - P5,5 - 9
PLUG (PN: 43-01063).
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RS232-Connector

5

4

Input Pin # Signal Pin # Output

Buchse M12x8 1 OUT1 1 Stecker M12x8

Buchse M12x8 2 OUT2 2 Stecker M12x8

Buchse M12x8 3 OUT3 3 Stecker M12x8

Buchse M12x8 5 VCC 5 Stecker M12x8

Buchse M12x8 6 GND 6 Stecker M12x8

Buchse M12x8 4 not connected 4 Buchse RS232

Buchse M12x8 6 GND 5 Buchse RS232

Buchse M12x8 7 RS232_Rx 2 Buchse RS232

Buchse M12x8 8 RS232_Tx 3 Buchse RS232
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iSYS-4001 iSYS-4002 / iSYS-4003 

Also see device datasheet: DataSheet iSYS-4000-SERIES - CABLE SET.pdf

Input Pin# Signal Pin# Output

Connector M12x8 female 1 OUT1 1 Connector M12x8 male

Connector M12x8 female 2 OUT2 2 Connector M12x8 male

Connector M12x8 female 3 OUT3 3 Connector M12x8 male

Connector M12x8 female 5 VCC 5 Connector M12x8 male

Connector M12x8 female 6 GND 6 Connector M12x8 male

Connector M12x8 female 4 not 
connected

4 Connector Sub-D-9 female

Connector M12x8 female 6 GND 5 Connector Sub-D-9 female

Connector M12x8 female 7 R485_A 2 Connector Sub-D-9 female

Connector M12x8 female 8 RS485_B 3 Connector Sub-D-9 female

Input Pin# Signal Pin# Output

Connector M12x8 female 1 OUT1 1 Connector M12x8 male

Connector M12x8 female 2 OUT2 2 Connector M12x8 male

Connector M12x8 female 3 OUT3 3 Connector M12x8 male

Connector M12x8 female 5 VCC 5 Connector M12x8 male

Connector M12x8 female 6 GND 6 Connector M12x8 male

Connector M12x8 female 4 not 
connected

4 Connector Sub-D-9 female

Connector M12x8 female 6 GND 5 Connector Sub-D-9 female

Connector M12x8 female 7 RS232_Rx 2 Connector Sub-D-9 female

Connector M12x8 female 8 RS232_Tx 3 Connector Sub-D-9 female
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3. start screen
After launching the GUI the start screen appears.

To connect the iSYS-4001 sensor to the GUI  
• click „COM Port Confi g“ 
• select your COM-Port
• set baud rate 
• set device address (default=128)
• click „Connect“
• click „Close“

During the connection process the GUI reads some parameters 
from the Sensor. The red lamp in the connection window 
switches to green if successfull.

Default baud rates:
• iSYS-4001 115 200 Baud
• iSYS-4002 115 200 Baud
• iSYS-4003    9 600 Baud
• iSYS-4010 115 200 Baud

The device address is only for RS485 communication interface 
required. Adapt this address in case of RS485 interface to the 
devices address you want to connect.
 

4. „Live View“
A click on „Start Live Stream“ starts displaying the live data in 
the opened tab.

4.1 Freeze/Run
For an improved analysis of the sensor data, the display can be 
frozen by clicking on “Freeze…”. To enable the live data again 
click on “Run…” .

4.2. Write all Params to EEPROM
This command writes all data into the EEPROM. This command  
is mandatory after setting all your parameters, otherwise all 
confi gurations made are lost.

5. „Save“ - „Load“ confi guration
To confi gure more than one sensor with the same settings all 
parameters can be saved in an *.ipf fi le.

5.1 Save confi guration to fi le
By clicking on “File” => “Save confi guration to fi le” the actual 
parameters will be saved in an *.ipf fi le.

5.2. Load confi guration from fi le
By clicking on “File” => “Load confi guration from fi le” parameter 
sets can be loaded. To write these parameters to the sensor click 
on “Write all parameters to EEPROM” otherwise the settings 
are lost after shutdown the sensor. The Standard confi guration is 
the “Short Range” parameter set (compare table beside). Other 
parameters sets are available @ www.innosent.de

select COM-Port

set baud rate to 115000

click to connect

click to start „Live View“

click to confi gure COM Port

Short Range.ipf

output1 approaching & receding 
active low, if object exist
open, if NO object exist

output 2 approaching
open, if object exist
active low, if NO object exist

output 3 receding
open, if object exist
active low, if NO object exist

rising delay 375ms

falling delay 75ms

fi lter type highest amplitude

single target fi lter 20% for all outputs

amplifi cation 20dB

distance range 0....50m

detection level 0dB
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7. tab „Raw Signals“ 

The Option „Raw Signals“ can be used to view the analog 
received signals.

The raw signals tab shows the signal raw data which sampled by 
the analog to digital converter.

6. frequency channels
To avoid interferences if two sensors are mounted close to each 

other 2 different frequency channels can be selected.

• click „Confi g“ 
• select „use channel 1“ or „use channel 2“ for using the 

sensor in Europe
• select „use channel 3“ or „use channel 4“ for using the 

sensor in the US

Channel 1 is corresponding to a transmit frequency of 24.190GHz

Channel 2 is corresponding to a transmit frequency of 24.210GHz

Channel 3 is corresponding to a transmit frequency of 24.115GHz

Channel 4 is corresponding to a transmit frequency of 24.135GHz

Channel 5-8 are available from fi rmware v1.310

Channel 5 is corresponding to a transmit frequency of 24.195GHz

Channel 6 is corresponding to a transmit frequency of 24.215GHz

Channel 7 is corresponding to a transmit frequency of 24.120GHz

Channel 8 is corresponding to a transmit frequency of 24.140GHz

8. tab „Detection“
This tab shows the FFT and the threshold calculated by the radar 
sensor.

The threshold consists of three parts:
• adaptive value, height of the threshold depending on the 

noise level
• low-pass fi lter, for the frequency selection of the different 

objects
• user defi ned threshold value, will be added to the threshold

8.1. User defi ned threshold values
Minimum:
The threshold is limited to a minimum value. This value can be 
adapted with the minimum slider.
Sensitivity:
The height of the low pass fi ltered signal can be changed with 
the sensitivity slider.

8.2. Linefi lter
By activating the Line Filters, several frequencies can be 
cancelled. This can be used for example to prevent interference 
from fl uorescent lamps.
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8.3 Threshold  adaption
Adapt the threshold within a few steps to a specifi c application scenario:

• Install the iSYS-400x in the real scenario
• Open the iSYS-GUI and connect to the device and start “Live View”
• The blue bars are the spectrum of the received signal and in green is plotted the threshold for detection
• Adapt the threshold by moving the “Minimum” slider. If you want to improve the detection range move the slider         
 to the left to shift the threshold down.
• For a proper function shift the detection line down as long you can see no detection. Take care that there are no
  available targets in your detection fi eld while adjusting. 

9. IF amplifi cation
The iSYS-4001 sensor features a variable IF amplifi cation with an 
8 Bit digital potentiometer. For changing the amplifi cation, open 
the amplifi cation window in „Confi g“ => „Amplifi cation“.

Manual amplifi cation:
Adapt the digital potentiometer step with the slider.
The button “Store” stores all actual set parameters including the 
amplifi cation into the devices EEPROM.
The fi gures beside are showing the amplifi cation for the different 
potentiometer positions.

Automatic amplifi cation:
Use the automatic amplifi cation if you have continuous signals 
with constant amplitudes.
If the signals does not exceed the inner threshold (orange area), 
the signal will be increased.
If the radar signal exceeds the inner threshold, but does not 
exceed the outer threshold (green area), nothing happens to the 
signal amplifi cation (signal is inside hysteresis).
If the radar signal exceeds the outer threshold, the signal 
amplifi cation will be decreased.
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10.  tab „output 1-3“ 

The iSYS-4001 offers 3 output signals that can be activated and 
confi gured independently of each other. 

The tabs “Output 1”, “Output 2” and “Output 3” shows the 
different target lists. Each target list has separate fi lter parameters 
which can be changed in the specifi c output tab.

During a live stream a colored button shows the actual status of 
the detected object:

• Green – object is receding
• Red – object is approaching
• Orange – no object detected

Show Histogram
By activating the Histogram option you can follow the time 
dependent trend of changes in speed and range of the object(s).

Target fi lter type:
While single target fi lter is deactivated all targets are shown in the different Plots. With an activated single target fi lter you 
can choose a fi lter type to get one target out of all detections. The fi lter type must be chosen depending on the application 
scenario. If unsure try the highest amplitude fi rst.

• Highest amplitude:  Get the target with the highest amplitude in the detection tab
• Mean velocity:    Get a target with the mean velocity from all target
• Median velocity:    Get a target with the median velocity from all targets
• Minimum velocity:     Get the target with the lowest velocity
• Maximum velocity:      Get the target with the highest velocity
• Mean range:        Get a target with the mean range from all target
• Median range:         Get a target with the median range from all targets
• Minimum range:         Get the target with the lowest range
• Maximum range:          Get the target with the highest range

The selection of the wanted option has a direct infl uence to the signals in the GUI as well as on the Output Confi guration.

Smoothing fi lter:
The “smoothing fi lter” fi lters the velocity and range values from successive measurements. By moving the slider you can 
adjust the degree of fi ltering. On the left side the fi lter is off and to the right the degree of fi ltering increases. Use this fi lter 
if you have a constant target.
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Target fi lter options:

The target fi lter options declare the velocity-, range- and signal-
area within the sensor is able to detect objects. Velocity has an 
additional option to set the sign of the velocity to detect only 
receding or approaching objects. 

The fi lters can be set in the following range:

iSYS-4001/ iSYS-4002/ iSYS-4010

Speed range:  0....250km/h
Distance range 1:  0....50m
Distance range 2:  0....150m
Signal Level:  0....250dB

11. digital output confi guration
To confi gure the output signals go to menu „Confi g“ => „Output 
Confi guration“

The output PINs can be activated and confi gured separately from 
each other.

Possible setting of output type are:

• digital     (open drain)                   
• pwm (velocity)   (open drain)      
• pwm (range)    (open drain)        

In case of „pwm“ a pulse-width modulated signal will be send 
to the output PINs corresponding to the speed or range of the 
objects (depending on which option is selected)

Output PIN confi guration:

confi guration description target detected output pin state

normally open low side switch yes high impedance

normally open low side switch no connected to GND

normally closed low side switch yes connected to GND

normally closed low side switch no high impedance

iSYS-4003

Speed range:  0....50km/h
Distance range 1:  0....50m
Distance range 2:  0....150m
Signal Level:  0....250dB
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Delay Confi guration:
This feature is used to infl uence the output timing of an object. To blank out false object, generated by noise measurement, 
you can set the rising delay. Therefore an object has to be detected some cycles in a row until the information is transmitted. 
The cycle time is 75ms. When the rising delay is set to 375ms it takes fi ve cycles until you can get target data. When rising 
delay is zero you get the data directly. The falling delay holds target information after it is undetected until the time has run 
out. With a falling delay of 75ms an object is one cycle active after the sensor lost detection. If you want to measure in 
real-time, rising and falling delay have to be set to zero.

Output type:
• digital:  Open as soon as there is a target available – otherwise LOW
• pwm (velocity): Streaming velocity information of “single target fi lter” coded with duty cycle
• pwm (range): Streaming range information of “single  target fi lter” coded with duty cycle

Duty cycle is calculated by the iSYS-400x by following formula:

Example confi guration for Output 1 set as “pwm (range)” and 
Output 2 set as “pwm (velocity)”, Output 3 is disabled

Output 1 (pwm range):

Output 2 (pwm velocity):

1.44m - 0m
20m - 0m

DC= *100=7.2%

25.1km/h - 0km/h
100km/h - 0km/h

DC= *100=25.1%

TON =7.2% * 25ms =1.8ms

TON =25.1% * 25ms = 6.275ms

OUT 2
Pwm (velocity)

OUT 1
Pwm (range)

Measured value - ThresholdminDC = Thresholdmax - Thresholdmin
100.

VCC-provided by the customer

6.275ms

25 ms

25 ms

1.8 ms

OUT 1

OUT 2

OUT 3 open drain

iSYS_4XXX

external pull up 
resistor
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14. Change RS485 address
Changing RS485 address is a special feature of the iSYS-4002 
and iSYS-4003. Open the slider window in the “Help” menu 
under “About”. Set the new device address and click set.

After changing the device address the command acknowledge is 
sent with the new device address.

Note: The address is written directly to the EEPROM.

15. Change RS232 / RS485 baudrate
The iSYS-4001 sensor supports different baudrates. For changing 
the baudrate, open the slider window in the “Confi g” menu 
under “Change Baudrate””.
Select new baudrate in dropdown menu and click “Change 
Baudrate”.

Note: The baudrate is written directly to the EEPROM.
Can  only changed if “Live View” stopped.

12. record & playback
The iSYS-4001 radar sensor features a record & playback 
functionality for raw data, fft & threshold and Targetlist. 
Depending on the active tab the specifi c data is recorded.

• record: Start recording with record button. Stop recording 
with stop button and chose fi le name and storage location. 
A fi lename including date and time is suggested.

• playback: Open playback window with play button. After 
opening a recoded fi le (xx.log) the playback can be started. 
Set the playback speed by adjusting the cycle time (The 
cycle time of the iSYS-4003 is 300 ms – all other devices 
working with 75 ms.).

13. GUI setting
Open in the GUI setting window in the “Confi g” menu. Change 
the units as useful for the measurements.
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Firmware is available @ www.innosent.de (Service -> Down-
loads -> Software) Software-Package folder: iSYS-4001_iSYS-
4002_iSYS-4003\Firmware\..

To start the fi rmware update go to menue „Help“ => „about“

16.1 sensor/GUI information

Information about the actual sensor fi rmware and GUI software

16.2 fi rmware update

To start the fi rmware update 

• select „update“  (1)

• select new fi rmware version (*.hex - fi le) (2)

• confi rm with button „fl ash fi rmware“ (3)

• wait until progress bar reaches 100% (4)
 
Note: Use same fi rmware iSYS-4001_vX.XXX.hex for all devices: 
4001, 4002, 4003, 4010

 (1)

 (2)

 (3)

 (4)

16. fi rmware



GUI description | iSYS-4001_4002_4003_4010 speed and distance sensor
www.InnoSenT.de

 13Experience and Reliability in Radar-Technology  -  www.InnoSenT.de

part numbers

contact information
If you have any questions please contact us!

Corinna Mergenthal

Tel.: +49-9528-9518-84

E-Mail: corinna.mergenthal@InnoSenT.de

Martin Maidhof

Tel.: +49-9528-9518-18

E-Mail: martin.maidhof@InnoSenT.de

P/N: iSYS-4001 P/N: iSYS-prog_adap P/N: iSYS-pow_adap P/N: iSYS-pow_supply
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